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New Features

The following new features have been added in version 11.4 of TIBCO Spotfire® Analyst.
For details about new Spotfire features, see What's New in TIBCO Spotfire in the TIBCO Community.

Key Version Summary

SPOT-499 11.4.0 Parallel data loading and computing

Data is now loaded and computed in parallel when opening an analysis file. This can

shorten the data loading time when you use data from multiple data sources. You will
also get all (non-error) prompts up front, which means that data loading can continue
until completed, without interruptions for prompts.

Using the installed client, it is possible to switch off the parallel data loading entirely
under Tools > Options > Document > Data loading, or, for a single analysis, through
File > Document properties > Compatibility Settings. An administrator can also
control the preferences for a group in Administration Manager > Preferences >
Application > DatalmportPreferences.

SPOT-1440 11.4.0 Single-tenant authentication support for SharePoint Online Lists
The TIBCO Spotfire Connector for SharePoint Online Lists now supports single-tenant
authentication.

TS-65517 11.4.0 Improved feature rendering in map charts

Spotfire uses geometry simplification techniques to facilitate the rendering of detailed
features on spatial maps, still preserving essential shapes. However, for rectangle
features that are typically represented by 4 or 5 points, the simplification might cause
rendering inconsistencies. In such cases you can specify the number of points below
which geometry simplification will not be used for features with less than 6 points.

SPOT-1445 11.4.0 Databricks SQL Analytics support

The TIBCO Spotfire connector for Apache Spark SQL now supports Databricks SQL
Analytics. You can now perform self-service visual data discovery on data lake data
using live pushdown querying in Databricks clusters which have SQL Analytics
enabled.

TS-66349 11.4.0 Custom repository setting for Python packages

The Spotfire administrator can now set a custom Python package repository for
use with Python Tools. To specify a custom repository for data function authors,
from the Spotfire Administration Manager Preferences dialog, set DataFunctions >
DataFunctionPreferences > PythonPackageRepositoryIndexURL.

TS-66059 11.4.0 Improved user action logging

Changing page through an IronPython script is now logged in the user action log.

SPOT-374 11.4.0 Trellising multiple layers in a map chart

The trellising of a map chart can now comprise more than one layer of data. This
makes it possible to compare multiple measures or categories of data within a single
geographical or diagrammatic map.

SPOT-1455 11.4.0 Improved performance for visualization mods

The performance of visualization mods has been significantly improved. The transfer
of data (rows and hierarchies) is now at least 100% faster for large data views and on
par with the performance of native visualizations.
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Key Version Summary

SPOT-1351 11.4.0 Automatic proxy detection

Python Tools Package Management now attempts to detect system proxy settings
automatically and uses them if they are available when searching for, or installing,
Python packages. Additional custom configuration options have been added to the
Administration Manager.

SPOT-1191 11.4.0 Added options for library items in the Files and data flyout

It is now possible to rename and delete items in the Spotfire library directly from
the Files and data flyout. You can also copy links to library items to share them with
others. To access the new options, right-click a library item in the Spotfire library
section of the Files and data flyout.
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Changes in Functionality

The following are important changes in functionality in version 11.4 of TIBCO Spotfire® Analyst.

Key Version Summary

TSDC-6660 11.4.0 For the TIBCO Data Virtualization connector the property enableFlood is activated
for requests from Spotfire, which could make communication with TIBCO Data
Virtualization unstable.

TSDC-6526 11.4.0 Improved import performance for the PostgreSQL connector

The UseDecl ar eFet ch option is now enabled in the TIBCO Spotfire PostgreSQL
connector to improve import performance.

TSDC-6525 11.4.0 Disabled caching improves import performance

In the TIBCO Spotfire MySQL connector, the NO_CACHE, FORWARD_CURSOR and
PREFETCH options are now used to improve import performance.

TSDC-6516 11.4.0 Performance changes for importing data with Amazon Redshift connections

To improve performance when you import data from Amazon Redshift, the option
Si ngl eRowbde is now enabled by default. You can override this by adding the
Si ngl eRowbde option in the Additional settings table and setting the value to 0.

TS-66631 11.4.0 Automatic signaling of render complete
A visualization mod automatically signals render complete when an error overlay is
shown.

T5-66560 11.4.0 New location for SetupLauncher when installing Spotfire

SetupLauncher, the program that performs the installation of a new version of Spotfire
Analyst, is now downloaded from the deployment area to a folder in the user's
AppData folder instead of a Temp folder.

The locally installed version of the program has been removed from the Modules

folder.

TS-66555 11.4.0 Increased max length of string mod properties
The maximum allowed length for mod properties of string type is now 100KB instead
of 2KB.

TS-66550 11.4.0 Updated Python interpreter

The Python interpreter included with Spotfire has been updated to version 3.8.10.

TS-66507 11.4.0 The Spotfire package available for download on PYPI

The Spotfire package is now a package available on PYPI and can be downloaded
by using the standard pip command. This change makes creating packages for
distribution simpler. If you are using your own Python interpreter, you can simply
install the 'spotfire’ package using pip instead of extracting the wheel from the
distribution and installing it.
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Key Version Summary
T5-66505 11.4.0 The spotfire Python module moved from the Core module to the Python Interpreter
module

The spot f i r e Python module for Analyst support of Python data functions has
moved from the Cor e module to the Pyt hon | nt er pret er module. If the Spotfire
Server administrator has deployed a custom Python interpreter package to the Spotfire
Server, then attempts to run data functions fail with errors about the spot f i r e module
(and mention using pi p install).

This failure with errors will continue until the Spotfire Server administrator deploys to
the Spotfire Server a new custom Python interpreter package that is built with version
1.3.0 (or later) of the spot f i r e Python package.

T5-65168 11.4.0 Save login information in Cloud Analyst

The 'Save my login information' option is now available for people connecting using
TIBCO Cloud Spotfire Analyst.

SPOT-1283 11.4.0 Unified experience for saving to, and browsing in, the library

The same Ul and style in the Files and data flyout is now used when saving an
analysis in the Spotfire library as when browsing the library. This unified experience is
available in the installed client as well as the web client.
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Deprecated and Removed Features

Deprecated features

The table lists features that are deprecated and will be removed in a future release of TIBCO Spotfire®
Analyst.

Key Version Summary

TS-66424 11.4.0 The jQuery 1.12.4 and jQuery UI 1.9.2 JavaScript libraries will not be distributed with
future releases of TIBCO Spotfire®. Your use of these third party libraries, whether
in this release, past releases, or future releases of TIBCO Spoitfire, is at your own
discretion, and is not supported or warranted by TIBCO. Please see Best Practices for
Writing Custom JavaScript Code in Text Areas for additional information on using
JavaScript code with Spotfire® products.

Deprecated since Spotfire 11.4.0.

TS-63679 114.0 The API to create requests to the server APIs, WebRequest Fact ory.
Creat eSpot fi reWebRequest (), has been deprecated in this release. All requests
to the server should be made using the standard APIs WebRequest . Creat eHt t p or
WebRequest . Cr eat eDef aul t instead. Authentication and authorization to the server
APIs is done using OAuth2 and registered API client credentials. See the following
documentation for more information.

Spotfire Server SOAP APIs
Spotfire Server REST APIs

Web Services API Reference
Library REST API

Deprecated since Spotfire 10.10.0.

Removed features

No features have been removed in this release of TIBCO Spotfire® Analyst.
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Closed Issues

The table lists important closed issues in version 11.4 of TIBCO Spotfire® Analyst.

Key Version Summary

TSS-28534 11.4.0 The property | nf or mat i onLi nkTi meout M nut es, which you can use in the
Information Designer to set a timeout for individual information links, is not
documented.

TSDC-6649 11.4.0 Authenticating a SharePoint Online connection using the client information from
preferences fails in the installed client with an error message stating that the client is
public.

TSDC-6623 11.4.0 Google Analytics is mentioned in the documentation about using a credentials profile

with Google data, but usage of credential profiles is not yet supported in the TIBCO
Spotfire Google Analytics connector.

TSDC-6583 11.4.0 For the TIBCO Spotfire connectors for Drill, Dremio, and Snowflake, connections are
not closed properly. This results in an accumulation of open connection handles. For
example, in the case of Snowflake connections, when logging is enabled, the driver
sometimes does not release log file handles until the connection is closed. This causes
the process to eventually run into the limit of allowed number of open file handles.

TSDC-6575 11.4.0 In the documentation there is not enough information about admin consent issues in
Microsoft Azure when connecting to SharePoint Online.

TSDC-6566 11.4.0 When using the Google BigQuery connector to import data, the import sometimes
consumes a lot of memory, which might lead to performance issues.

TS-66784 11.4.0 It is not possible to reload an embedded data table when it is based on an on-demand
source and has added rows from a different data source.

TS-66734 11.4.0 Sometimes it is not possible to zoom in or out in the map chart using the + and -
buttons that are available in the visualization, even though it should be possible.

TS-66729 11.4.0 Preference values that are specified in a cobranding package are not used the first time
a different user than the previous user logs in.

TS-66723 11.4.0 If an error occurs while signing in to SharePoint Online using the TIBCO Spotfire
SharePoint Online connector, the real error is hidden by a more general error.

TS-66649 11.4.0 For some Microsoft Excel cells that use array formulas, empty values are incorrectly
imported.
TS-66531 11.4.0 After installing TIBCO Spotfire version 10.9 or higher on a computer where another

version is already installed, it is not possible to uninstall any of the versions.

With this fix, uninstalling TIBCO Spotfire no longer leaves unwanted files on disk,
when multiple versions have been installed on the same computer.

TS-66522 11.4.0 Loading information links might cause issues when running several TIBCO Spotfire
Server instances (clustered TSS).

TS-66462 11.4.0 Right-clicking top scale labels in a heat map results in errors in some situations.
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Key Version Summary

TS-66343 11.4.0 In some cases it is possible to replace individual values from the UNIQUE values
overview in the column details in the Data in analysis flyout even though it should not
be possible.

TS-66342 11.4.0 Memory usage increases when running a specific script that applies a large number of
markings in an analysis with wide data and a tabular visualization.

T3-66338 11.4.0 In a scatter plot, the Spotfire client sometimes closes unexpectedly when switching
between post-aggregating expressions on an aggregated axis using Time as the data
type.

T5-66320 11.4.0 A certain script, which applies a large number of markings in an analysis with wide
data, runs much slower in version 10.x and 11.x of Spotfire compared to version 7.x.

TS-66247 11.4.0 Sometimes, usage.log files that contain cluster identifiers are not parsed correctly.

TS-66244 11.4.0 Map charts sometimes stop updating when panning is done on a page with iframes on
it, for example JSViz or visualization mods.

T3-66219 11.4.0 Spotfire closes unexpectedly when all values are deleted from a drop-down list with
fixed values during editing of a text area.

TS-66186 11.4.0 When exporting a trellised scatter plot, only the image labels for the first trellis panel
are exported when the display option ‘Image from URL' is used.

T3-66143 11.4.0 Frozen columns originating from data functions disappear when opening the analysis.

TS-66105 11.4.0 The location search field and button are pushed behind the other navigation controls
in some trellised map charts.

TS-65984 11.4.0 If you use Spotfire Service for Python to run Python data functions, and you use
Spotfire Statistics Services to run TERR data functions, then the client (either Spotfire
Analyst or Spotfire Business Author) can mistakenly try to run the TERR data
functions in a nonexistent TERR service, rather than Spotfire Statistics Services,

causing the data function to wait indefinitely.

TS-65973 11.4.0 File URIs do not work in the "Image from URL" renderer.

TS-65953 11.4.0 When exporting a prepared report to PDF, headers and footers are sometimes
rendered incorrectly.

T5-65520 11.4.0 Failure to persist author trust to the server is not reflected in the mods trust dialogs.

TS-48313 11.4.0 The documentation about use of prepocessor expressions (for example, when
using document properties inserted as text) is not clear enough. See Properties in
Expressions and related topics.

TS-38646 11.4.0

The documentation about marking in visualizations contains too little detail about the

behavior when using Ctrl+A.
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Known Issues

There are no important known issues to report in version 11.4 of TIBCO Spotfire® Analyst.
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Installation

The following are instructions on how to install version 11.4 of TIBCO Spotfire® Analyst.

The TIBCO Spotfire® Analyst client is delivered as two different installers. The installer labelled
"single_user" is the default one. Use this if you do not know which version to select. The installer
labelled "single_user" installs the product for the logged in user only. The other users on the same
machine will not be able to use the client. The installer labelled "shared_computer" installs the product
for all users on the machine. This installer requires administrative privileges on the machine.

Installation of Release 11.4

1. First install/upgrade the TIBCO Spotfire® Server to version 11.4.
2. Deploy the TIBCO Spotfire® 11.4 distribution on the TIBCO Spotfire® Server 11.4.
3. Finally, install TIBCO Spotfire® Analyst 11.4 on all client computers.

Installation Notes

o If the NET 4.5 framework is not installed, it will be downloaded and installed when launching the
"shared_computer" TIBCO Spotfire® Analyst client installer. The "single_user" installer will not
download the .NET framework, because it does not have system changing privileges. However, it
will complain if the .NET framework is missing.

o If the product localization is defined as a user group preference, a client restart is required after
the initial login to the server for the changes to be fully applied. Note that clients are not informed
that such a restart is required. It is also important that the appropriate localization packages are
deployed to the TIBCO Spotfire® Server prior to setting the user group preference.

Note that the correct Language pack and the matching server preference must be set on the very
first server that the user connects to. Changing the settings on the Server will not have any effect. If
the localization group preference does not have any effect, it can be enforced on clients using Tools
> Options.
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Migration and Compatibility

The following are instructions on how to migrate from a previous release to version 11.4 of TIBCO
Spotfire® Analyst.

Upgrading from Previous Version without Installing

1. First install/upgrade the TIBCO Spotfire® Server to version 11.4.
2. Deploy the TIBCO Spotfire® 11.4 distribution on the TIBCO Spotfire® Server 11.4.

3. Start the old version of TIBCO Spotfire® Analyst, log on to the TIBCO Spotfire® Server 11.4 and
accept the update.

With Spotfire 10.3, a trust mechanism for data functions was introduced. Also, the trust stamp
was changed to be calculated with SHA-512. Therefore, when updating from an older version to
10.3 or later, the trust stamps in all Spotfire analysis files in the library that include IronPython
& scripts, JavaScripts, data connection custom queries or data functions must be updated. New
server CLI commands called "find-analysis-scripts" and "trust” can be used to find and update
or automatically trust old scripts and data functions in your library. For more information, see
the TIBCO Community article: https://community.tibco.com/wiki/script-and-data-function-trust-
spotfire-103-and-later.

Compatibility Versions

You can use TIBCO Spotfire 11.4 to open .dxp analysis files that were created and saved in any older
version of Spotfire that is still in support.

The compatibility versions of TIBCO Spotfire 11.4 are updated to versions 11.3 and 10.10 LTS. This
means that .dxp analysis files that you create and save in Spotfire 11.4 can be opened in versions 11.3
and 10.10 LTS of Spotfire.

When you use an older version of Spotfire to open an analysis file that was created in a newer
& version of Spotfire, features from the newer version might not be available, and the analysis
might look and behave differently compared to the version in which it was created.

Version Compatibility versions
114 LTS 11.3,10.10 LTS
11.3 11.2,10.10 LTS
11.2 11.1,10.10 LTS
11.1 11.0,10.10 LTS
11.0 10.10 LTS, 10.3 LTS
10.10 LTS 10.9, 10.3 LTS
10.9 10.8,10.3 LTS
10.3 LTS 10.2,7.11 LTS
711LTS 711LTS
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File compatibility example
For example, when you create a . dxp analysis file in Spotfire 11.3, the file is saved with

compatibility versions for 11.2 and 10.10 LTS. You can open the . dxp file in any older Spotfire
version that either is one of those versions, or has 11.2 or 10.10 as compatibility versions.

That means you can open the . dxp analysis file that you saved in Spotfire 11.3 in the following
older versions: 11.2, 11.1, 11.0 and 10.10 LTS.

Newer and older versions of Spotfire Analyst client can be used to connect to the current version of
Spottfire Server in order to upgrade or downgrade the client packages. However, it is recommended
to always run the same version of client and server in production environments. See System
Requirements.
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TIBCO Documentation and Support Services

For information about the Spotfire products, you can read the documentation, contact TIBCO Support,
and join the TIBCO Community.

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation website, mainly
in HTML and PDF formats.

The website is updated frequently and is more current than any other documentation included with the
product.

TIBCO Spotfire Documentation

The documentation for all Spotfire products is available on the TIBCO Spotfire® Documentation page.
This page takes you directly to the latest version of each document.

To see documents for a specific Spotfire product or version, click the link of the product under 'Other
versions', and on the product page, choose your version from the top right selector.

Release Version Support

Some release versions of TIBCO Spotfire products are designated as long-term support (LTS) versions.

LTS versions are typically supported for up to 36 months from release. Defect corrections will typically
be delivered in a new release version and as hotfixes or service packs to one or more LTS versions. See

also https://docs.tibco.com/pub/spotfire/general/LTS/spotfire_LTS_releases.htm.

How to Contact TIBCO Support
Get an overview of TIBCO Support. You can contact TIBCO Support in the following ways:

o For accessing the Support Knowledge Base and getting personalized content about products you are
interested in, visit the TIBCO Support portal at https://support.tibco.com.

» For creating a Support case, you must have a valid maintenance or support contract with TIBCO.
You also need a user name and password to log in to https://support.tibco.com. If you do not have a
user name, you can request one by clicking Register on the website.

System Requirements for Spotfire Products

For information about the system requirements for Spotfire products, visit http://spotfi.re/sr.

How to join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee subject matter
experts to share and access their collective experience. TIBCO Community offers access to Q&A forums,
product wikis, and best practices. It also offers access to extensions, adapters, solution accelerators, and
tools that extend and enable customers to gain full value from TIBCO products. In addition, users can
submit and vote on feature requests from within the TIBCO Ideas Portal. For a free registration, go to
https://community.tibco.com.

For quick access to TIBCO Spotfire content, see https://community.tibco.com/products/spotfire.

TIBCO Spotfire® Analyst Release Notes


https://docs.tibco.com
https://docs.tibco.com/products/tibco-spotfire/
https://docs.tibco.com/pub/spotfire/general/LTS/spotfire_LTS_releases.htm
http://www.tibco.com/services/support
https://support.tibco.com
https://support.tibco.com
http://spotfi.re/sr
https://ideas.tibco.com/
https://community.tibco.com
https://community.tibco.com/products/spotfire

15

Legal and Third-Party Notices

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH
EMBEDDED OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY
(OR PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE
EMBEDDED OR BUNDLED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY
OTHER TIBCO SOFTWARE OR FOR ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND
CONDITIONS OF A LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED
SOFTWARE LICENSE AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE
CLICKWRAP END USER LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD
OR INSTALLATION OF THE SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE

FILE) OR IF THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END
USER LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN THE "LICENSE" FILE(S) OF THE
SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND
YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE
BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this document
may be reproduced in any form without the written authorization of TIBCO Software Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, TIBCO Spotfire, TIBCO Spotfire Analyst, TIBCO Spotfire
Automation Services, TIBCO Spotfire Server, TIBCO Spotfire Web Player, TIBCO Enterprise Runtime
for R, TIBCO Enterprise Runtime for R - Server Edition, TERR, TERR Server Edition, and TIBCO
Spotfire Statistics Services are either registered trademarks or trademarks of TIBCO Software Inc. in the
United States and/or other countries.

All other product and company names and marks mentioned in this document are the property of their
respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating system
platforms for a specific software version are released at the same time. See the readme.txt file for the
availability of this software version on a specific operating system platform.

THIS DOCUMENT IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL
ERRORS. CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE
CHANGES WILL BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO
SOFTWARE INC. MAY MAKE IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/
OR THE PROGRAM(S) DESCRIBED IN THIS DOCUMENT AT ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY
OR INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE,
INCLUDING BUT NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This and other products of TIBCO Software Inc. may be covered by registered patents. Please refer to
TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.

Copyright © 1994-2021. TIBCO Software Inc. All Rights Reserved.
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